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Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous 
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les instruc-
tions de ce chapitre. Pour une liste plus détaillée, voyez l’Aide de l’application.

Windows ou Linux Équivalent Mac Effet

Sélection du menu 
Outils > Options

LibreOffice > Préférences Accès aux options de configuration

Clic droit Control+clic ou clic 
droit selon la configuration 
de l’ordinateur

Ouvre un menu contextuel

Ctrl (Control) ⌘ (Command) Utilisé avec d’autres touches

F5 Shift+⌘+F5 Ouvre le Navigateur

F11 ⌘+T Ouvre la fenêtre Styles et Formatage

La documentation française de LibreOffice est disponible à
https://wiki.documentfoundation.org/Documentation/Publications/fr
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Qu’est-ce que Draw ?

Draw est un outil de dessin vectoriel, qui peut également effectuer quelques opérations sur des 
images matricielles (pixels). Avec Draw, vous pouvez réaliser rapidement une grande variété 
d’images graphiques.

Un outil de dessin vectoriel permet de stocker et d’afficher une image en tant qu’ensemble d’élé-
ments géométriques simples, comme des lignes, des cercles et des polygones, plutôt qu’un en-
semble de pixels (éléments d’images ou points à l’écran). Ceci permet un stockage plus simple et 
un changement de dimension plus précis des éléments de l’image.

Draw est complètement intégré à la suite LibreOffice, ce qui simplifie les échanges de dessins vec-
toriels avec tous les modules de la suite. Par exemple, si vous créez un dessin dans Draw et que 
vous voulez l’utiliser dans un document Writer, il vous suffit de le copier et de le coller. Vous pou-
vez également travailler sur des dessins directement dans Writer ou dans Impress en utilisant un 
sous-ensemble de fonctions et d’outils de Draw.

Les fonctionnalités de Draw sont très complètes et, bien qu’il n’ait pas été conçu pour rivaliser 
avec des applications graphiques spécialisées, il possède néanmoins plus de fonctions que les ou-
tils de dessin habituellement intégrés dans les suites bureautiques.

On peut citer de manière non exhaustive parmi les fonctions de dessin la gestion de couches, un 
système complet de points magnétiques, le tracé de cotations associatives, des connecteurs facili-
tant la réalisation d’organigrammes, des fonctions 3D permettant de réaliser de petits dessins tridi-
mensionnels (avec entre autres la gestion des textures et des éclairages), l’intégration de styles de
dessin et de pages et le tracé de courbes de Bézier.

Ce chapitre aborde quelques fonctionnalités de Draw sans essayer d’être exhaustif. Veuillez vous 
reporter au Guide Draw et à l’aide de l’application pour plus d’informations.

La fenêtre principale de Draw

Les essentiels éléments de la fenêtre principale de Draw sont visibles sur la Figure 1 :

• la barre de menu ;

• la barre d’outils standard ;

• le volet Pages ;

• l’espace de travail ;

• la barre d’état ;

• la barre des couches ;

• la barre d’outils Dessin ;

• le volet latéral.

L’espace de travail

La zone la plus large au centre de la fenêtre (Espace de travail) est l’endroit où vous créez vos 
dessins. Elle peut être entourée de barres d’outils et d’espaces d’information. Le nombre et l’em-
placement des outils visibles varient avec la tâche en cours et les préférences de l’utilisateur, donc 
la disposition de votre fenêtre peut être différente de celle de la Figure 1.
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Dans LibreOffice Draw, la taille maximum d’un dessin est 300 cm sur 300 cm.

Volet Pages

Barre d’état

Espace de travail

Barre d’outils 
Dessin Barre de menu

Barre d’outils 
Standard Volet latéral

Barre de couches

Figure 1 : L’espace de travail de LibreOffice Draw

Le volet Pages

Vous pouvez disposer des dessins dans Draw sur plusieurs pages. Ceux-ci sont surtout utilisés 
par des présentations. Le volet Pages donne un aperçu des pages que vous avez créées dans 
votre dessin. Si ce volet n’est pas visible, sélectionnez Affichage dans la barre de menu et cliquez
sur Volet Pages. Pour modifier l’ordre des pages, faites glisser et déposez une ou plusieurs 
pages.

La barre de couches

Une couche est un espace où vous pouvez insérer des éléments et des objets de votre dessin. La 
barre de couches est située en bas de l’espace de travail et contient les onglets et les outils pour la
sélection et la commande des couches. Pour plus d’information sur les couches, voyez « Utiliser 
les couches » page 5.

Le volet latéral

Le volet latéral possède cinq onglets. Pour en afficher un, cliquez sur son icône ou sur le bouton 
Paramètres du volet latéral ( ) au-dessus des icônes et choisissez un onglet dans la liste dé-
roulante. Un seul onglet peut être ouvert à la fois. Si le volet latéral n’est pas visible, sélectionnez 
Affichage dans la barre de menu et cliquez sur Volet latéral.
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Propriétés

Ouvre des panneaux pour les propriétés de l’objet que vous pouvez modifier à votre conve-
nance. Ces panneaux sont Caractère, Paragraphe, Zone, Ombre, Ligne et Position et taille.

Si aucun objet n’est sélectionné, le panneau indique les propriétés de la page.

Styles et formatage

Ici, vous pouvez modifier et appliquer des styles d’image aux objets de votre dessin. Quand 
vous modifiez un style, les changements sont automatiquement appliqués à tous les élé-
ments de votre dessin mis en forme avec ce style.

Formes

L’onglet Formes vous permet de sélectionner par un simple clic la forme que vous allez des-
siner sur votre page.

Galerie

Ouvre la galerie d’images à partir de laquelle vous pouvez insérer un objet dans votre des-
sin, soit comme copie, soit comme lien. Une copie d’un objet est indépendante de l’objet 
d’origine. Les modifications de celui-ci n’ont aucun effet sur la copie. Un lien reste dépendant
de l’objet d’origine. Les modifications de celui-ci se reflètent aussi sur l’objet lié.

Navigateur

Ouvre le navigateur de Draw où vous pouvez rapidement atteindre une autre page de votre 
dessin ou sélectionner un objet dans une figure. Il est recommandé de donner aux pages et 
aux objets de votre dessin des noms significatifs pour pouvoir facilement les identifier dans le
navigateur.

Les règles

Vous pouvez voir les règles (des barres graduées) en haut et à gauche de la zone de dessin de 
Draw. Si elles ne sont pas visibles, vous pouvez les faire apparaître en sélectionnant Affichage > 
Règles depuis la barre de menus.

Les règles montrent la taille de l’objet sélectionné sur la page au moyen de lignes doubles (entou-
rées en vert dans la Figure 2). Quand aucun objet n’est sélectionné, elles montrent la position du 
pointeur de la souris pour vous aider à positionner plus précisément les objets dessinés.

Figure 2 : Règles montrant la taille de l’objet sélectionné
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Vous pouvez également utiliser les règles pour manipuler les poignées des objets et les lignes de 
capture. Vous pouvez ainsi cliquer et faire glisser une ligne double pour modifier la taille de l’objet 
sélectionné.

Les marges de la page sont indiquées par une zone grisée à l’intérieur des règles. Vous pouvez 
modifier les marges directement dans les règles en les fai-
sant glisser avec la souris. Les marges sont représentées par
la surface grise au-delà des règles visibles sur la Figure 3.

La position par défaut du zéro pour chacune des règles est
située dans le coin supérieur gauche de la page, après les
marges gauche et supérieure (voir Figure 3). Cette position
du zéro peut être modifiée en cliquant sur l’endroit où les

règles horizontale et verticale se rejoignent ( ) et en faisant
glisser jusqu’à la position désirée.

Pour modifier l’unité de mesure, qui peut être définie séparé-
ment, faites un clic droit sur la règle désirée, comme sur la
Figure 3, et choisissez une unité de mesure dans la liste dé-
roulante.

La barre d’état

La barre d’état est située au bas de la fenêtre Draw comme dans tous les modules LibreOffice. 
Elle comprend plusieurs zones spécifiques à Draw (Figure 4). Pour les détails et l’utilisation de ces
champs, veuillez vous reporter au chapitre 1, Introduction à LibreOffice de ce Guide du débutant et
au chapitre 1, Introduction à Draw du Guide Draw.

Nombre et 
numéro de diapo

Informations sur 
la sélection

Nom de la diapo 
maîtresse

Signature électronique

Position et taille de 
l’objet sélectionné

Réglage 
du zoom

Pourcentage 
de zoom

Document modifié

Adapter la diapo à 
la fenêtre active

Figure 4 : La barre d’état de Draw

Remarque

Les nombres des positions et tailles sont exprimés dans l’unité de mesure en cours définie 
dans la page LibreOffice Draw – Général de la boîte de dialogue Options (Outils > Options 
dans la barre de menu), et non dans l’unité de mesure définie pour la règle.

4 | Débuter avec Draw

Figure 3 : Les unités pour les règles



Les barres d’outils

Pour masquer ou afficher les barres d’outils de Draw, sélectionnez Affichage > Barres d’outils 
dans la barre de menu. Dans la liste qui s’ouvre alors, choisissez les barres d’outils que vous vou-
lez afficher. Pour plus d’information sur le travail avec les barres d’outils voyez le chapitre 1, Intro-
duction à LibreOffice dans ce guide.

Les barres d’outils disponibles dans Draw sont présentées dans les paragraphes suivants. L’appa-
rence de leurs icônes peut dépendre de votre système d’exploitation et du choix de leur style et de 
leur taille dans la page LibreOffice – Affichage de la boîte de dialogue Options (Outils > Options).

La barre d’outils Standard

La barre d’outils Standard est semblable dans tous les modules de LibreOffice et n’est pas décrite 
en détail dans ce chapitre. Elle est située par défaut sous la barre de menu.

La barre d’outils de dessin

La barre d’outils Dessins est la plus importante de Draw. Elle contient toutes les fonctions néces-
saires pour dessiner diverses formes géométriques ou à main levée et pour les organiser sur la 
page. Elle est ancrée par défaut sur la gauche de la fenêtre de Draw.

La barre d’outils Ligne et remplissage

Utilisez la barre d’outils Ligne et remplissage pour modifier les propriétés principales d’un objet de 
dessin. Les icônes et les listes déroulantes changent selon le type d’objet sélectionné. Par 
exemple, pour modifier le style d’une ligne, cliquez sur la flèche vers le bas de la liste déroulante 
Style de ligne et choisissez le style désiré.

Les fonctions de cette barre d’outils se retrouvent aussi dans l’onglet Propriétés du volet latéral 
quand un objet de dessin est sélectionné. Par défaut, cette barre d’outils n’est pas affichée mais 
vous pouvez le faire à partir du menu Affichage > Barres d’outils.

La barre d’outils Formatage du texte

Si l’objet sélectionné est un texte, le volet latéral propose les choix de mise en forme appropriés 
dans son onglet Propriétés. Par défaut, la barre d’outils Formatage du texte n’est pas affichée mais
vous pouvez le faire à partir du menu Affichage > Barres d’outils. Si vous avez activé à la fois la 
barre d’outils Ligne et remplissage et la barre d’outils Formatage du texte, Draw affiche l’une ou 
l’autre selon l’objet sélectionné.

La barre d’outils Options

Utilisez la barre d’outils Options pour activer ou non diverses aides au tracé. Par défaut, elle n’est 
pas affichée mais vous pouvez le faire à partir du menu Affichage > Barres d’outils.

Utiliser les couches

L’utilisation des couches vous permet de créer des images complexes en empilant des figures plus
simples sur chaque couche. La partie d’une couche qui ne contient aucun objet est transparente. 
Vous pouvez ajouter le nombre de couches que vous voulez dans votre document. Une couche 
peut être visible ou masquée, imprimable ou non, verrouillée ou non. Les couches sont communes
à toutes les pages d’un dessin.

Un document Draw contient trois couches par défaut que l’on ne peut ni renommer ni supprimer. 
Voici la manière courante de les utiliser :
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• Mise en page : c’est là que vous placerez les titres, le texte et les emplacements réservés 
pour les objets de votre page.

• Contrôles : cette couche est toujours au-dessus des autres. Vous y mettrez les boutons et 
les autres contrôles de votre dessin.

• Lignes de cote : c’est là que vous placerez les lignes de cote de votre objet si nécessaire.

Pour plus d’information sur les Techniques avancées dans Draw, voir le chapitre 11 du Guide 
Draw.

Ajouter une couche

Pour ajouter une couche à votre dessin, choisissez Insertion > Couche… dans la barre de menu 
ou faites un clic droit sur l’onglet de n’importe quelle couche dans barre d’onglets en bas de l’es-
pace de travail (Figure 1) et choisissez Insérer une couche… dans le menu contextuel. La boîte 
de dialogue Insérer une couche s’ouvre.

Figure 5 : La boîte de dialogue Insérer une couche

Donnez un nom, un titre et une description à la couche. Décidez si vous voulez qu’elle soit impri-
mable ou non, visible ou masquée ou verrouillée pour éviter des modifications accidentelles à 
l’avenir.

Une couche masquée est toujours visible dans la Barre de couches, mais son nom est en bleu. 
Pour basculer rapidement entre l’état Visible/Invisible d’une couche, faites Maj+Clic sur le nom de 
la couche. Vous ne pouvez pas changer l’ordre des couches dans cette barre.

Remarque

Les couches ne définissent pas l’ordre d’empilement des objets sur une page, sauf pour la 
couche Contrôles qui est toujours devant les autres. L’ordre d’empilement des objets est dé-
terminé par la séquence de leur création. Vous pouvez le modifier par le menu Modifier > 
Disposition.
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Choisir et définir des couleurs

Barre de couleurs

Pour afficher la barre de couleurs, sélectionnez Affichage > Barres d’outils > Barre de couleurs.
Par défaut, elle apparaît en bas de l’espace de travail (Figure 6) et affiche les couleurs de la pa-
lette en cours. Vous pouvez la masquer ou l’afficher en cliquant sur son bouton Masquer/Afficher 
(entouré en vert sur la Figure 6) Elle vous permet de sélectionner rapidement la couleur de diffé-
rents objets (lignes, zones et effets 3D) de votre document. La première case du panneau corres-
pond à invisible (pas de couleur).

Figure 6 : Barre de couleurs

Choisir une palette de couleurs

Vous pouvez accéder à plusieurs palettes de couleurs spécialisées dans Draw. Vous pouvez éga-
lement modifier les couleurs individuelles selon votre goût. Ceci s’effectue dans la boîte de dia-
logue Remplissage (Figure 7), qui apparaît en choisissant Format > Remplissage depuis la barre 
de menus ou en cliquant sur l’icône Remplissage  la barre d’outils Ligne et remplissage. Dans 
cette boîte de dialogue, cliquez sur l’onglet Couleurs. Pour charger une autre palette, sélectionnez-
la dans la liste déroulante Palette.

Conseil

La même liste déroulante est disponible quand vous sélectionnez une couleur dans le volet 
latéral.

Pour ajouter une couleur à la palette personnalisée, commencez par la sélectionner en cliquant sur
le bouton Choisir une couleur avant de l’ajuster à l’aide de la boîte de dialogue Choisir une couleur
qui s’ouvre alors. Vous pouvez effectuer les modifications en déplaçant le curseur rond dans le 
carré coloré et en cliquant sur la barre multicolore qui se trouve à sa droite, ou en changeant les 
valeurs numériques des champs situés à la droite de la boîte de dialogue pour les trois schémas 
de couleurs proposés.

Voir la section Options de couleur au chapitre 2, Paramétrer LibreOffice de ce guide. Une descrip-
tion plus détaillée des palettes de couleurs, de leurs options et de la différence entre les schémas 
de couleur RVB et CMJN figure dans le chapitre 11, Techniques avancées de Draw du Guide 
Draw.
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Figure 7 : L’onglet Couleur de la boîte de dialogue Remplissage

Figure 8 : la boîte de dialogue de sélection de couleur.
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Dessiner les formes de base

Draw offre une large gamme de formes, situées dans les palettes accessibles par la barre d’outils 
Dessin. Cette partie ne décrit que quelques formes de base, y compris le texte, qui sont traitées 
comme des objets par Draw. Voyez le Guide Draw pour une description complète des formes dis-
ponibles.

Certaines icônes de la barre d’outils Dessin changent en fonction de la forme qui a été sélection-
née parmi les choix possibles. Les icônes qui ouvrent une palette d’outils affichent un petit triangle 
à leur droite.

Remarque

Quand vous dessinez une forme élémentaire ou que vous la sélectionnez pour la modifier, le
champ d’information à la gauche de la barre d’état change pour correspondre à l’action en 
cours : par exemple, Créer ligne, Cadre de texte xxxx sélectionné, etc.

Dessiner des lignes droites

Cliquez sur l’icône Ligne  et placez le curseur de la souris à l’endroit où vous voulez que la 
ligne commence. Faites glisser la souris en gardant son bouton gauche appuyé. Relâchez le bou-
ton de la souris à l’endroit où vous voulez que la ligne se termine. Une poignée de sélection appa-
raît à chaque extrémité de la ligne, ce qui indique que cet objet est l’objet actuellement sélectionné
(Figure 9). La poignée de sélection au début de la ligne est légèrement plus grande que l’autre.

Au cours de votre manipulation de la ligne (ou d’un autre élément), vous pouvez utiliser la zone 
d’information de la barre d’état pour contrôler votre action. Le premier exemple de la Figure 9 vous
montre la zone d’information au cours du tracé d’une ligne. Le second exemple vous montre cette 
même zone une fois la ligne tracée.

Figure 9 : Tracer un segment.

Maintenez la touche Ctrl enfoncée pendant le tracé de la ligne pour que son extrémité se ver-
rouille au sommet le plus proche de la grille.

Remarque

Il s’agit du comportement par défaut de la touche Ctrl. Cependant si l’option Aligner sur la 
grille a été sélectionnée dans le menu Affichage > Grille et lignes guide, la touche Ctrl 
désactive l’attraction par la grille.

Si vous maintenez la touche Maj appuyée durant le tracé de la ligne, cela restreint son angle à un 
multiple de 45 degrés (0, 45, 90, 135, etc.).
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Remarque

Ceci est le comportement par défaut de la touche Maj. Cependant, si l’option Lors de la 
création ou du déplacement des objets de la section Contraindre les objets est cochée 
dans la page LibreOffice Draw – Grille de la boîte de dialogue Options (Outils > Options 
dans la barre de menu), l’action de la touche Maj est inversée. Les lignes seront automati-
quement tracées avec un angle multiple de 45 degrés, à moins que la touche Maj ne soit 
appuyée.

Maintenir la touche Alt enfoncée lors du tracé d’une ligne permet de tracer la ligne symétrique-
ment dans les deux directions à partir du point de départ. Ceci vous permet de commencer par le 
milieu de la ligne.

Quand une ligne est dessinée, elle utilise des attributs par défaut. Pour modifier ces attributs et ou-
vrir la boîte de dialogue Ligne (Figure 10), sélectionnez la ligne en cliquant sur elle, puis

• faites un clic droit et choisissez Ligne dans le menu contextuel,

• cliquez sur l’icône Ligne  de la barre d’outils Ligne et remplissage,

• choisissez Format > Ligne dans la barre de menu.

• Cliquez sur l’icône Propriétés  du volet latéral et ouvrez le panneau Ligne.

Le style, la largeur et la couleur de la ligne peuvent également être modifiés directement, après 
avoir sélectionné la ligne, en utilisant les boutons de la barre d’outils Ligne et remplissage.

Figure 10 : La boîte de dialogue Ligne
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Dessiner des flèches

Les flèches se tracent de la même façon que les lignes. En fait, Draw répertorie les flèches dans 
un sous-groupe de lignes : les lignes avec une ou deux flèches. La zone d’information de la barre 
d’état ne les désigne que comme des lignes. Cliquez sur l’icône Lignes et flèches  pour dessi-
ner une flèche. La flèche est dessinée à la fin de la ligne, à l’endroit où vous relâchez le bouton de 
la souris.

Choisir les extrémités

Plusieurs sortes d’extrémités (flèches, cercles, carrés et d’autres encore) sont disponibles dans 
Draw. Cliquez sur le petit triangle à droite de l’icône Lignes et flèches de la barre d’outils Dessin 
pour ouvrir une palette d’outils contenant ceux qui vous permettront de tracer des lignes et des 
flèches (Figure 11). Vous pouvez aussi sélectionner Affichage > Barres d’outils > Flèches pour 
ouvrir cette palette d’outils. L’icône du dernier outil utilisé apparaîtra dans la barre d’outils Dessin 
pour faciliter sa réutilisation.

Figure 11 : La barre d’outils Flèches

Après avoir tracé une ligne, vous pouvez modifier ses extrémités en cliquant sur l’icône Style de 
flèche  de la barre d’outils Ligne et remplissage puis en choisissant le style de chaque extrémi-
té. Vous pouvez effectuer les mêmes modifications dans le panneau Ligne de l’onglet Propriétés 
du volet latéral ou dans la boîte de dialogue Ligne. Voir le chapitre 4, Modifier les attributs d’un ob-
jet du Guide Draw pour plus d’informations.

Dessiner une ligne de cote

Les lignes de cotes affichent les dimensions d’un objet dans le dessin (Figure 12). Les lignes de 
cotes ne font pas partie de l’objet lui-même mais sont normalement placées près de lui. Un objet 
peut avoir autant de lignes de cotes que nécessaire pour indiquer les mesures de ses côtés, bords
et distances.

4,16 cm

2,
7

 c
m

Figure 12 : Mesure d’un objet avec des lignes de cotes

Les lignes de cotes calculent et affichent automatiquement les dimensions linéaires.

Pour tracer une ligne de cote, ouvrez la barre d’outils Flèches (Figure 11) et cliquez sur l’icône 
ligne de cote . Maintenez la touche Maj enfoncée pour facilement tracer la ligne de cote hori-
zontale ou verticale. Déplacez le pointeur de la souris à l’emplacement du début de la ligne et tra-
cez celle-ci. Relâchez le bouton gauche de la souris à l’emplacement de la fin de la ligne.
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Vous pouvez contrôler l’apparence des composants de la ligne de cote en la sélectionnant, en fai-
sant un clic droit sur celle-ci et en choisissant Cotation dans le menu contextuel pour ouvrir la 
boîte de dialogue Cotation (Figure 13).

Figure 13 : Boîte de dialogue de configuration des lignes de cotes

Dessiner des rectangles ou des carrés

Le tracé d’un rectangle ressemble à celui d’une ligne droite. Cliquez sur l’icône Rectangle  de 
la barre d’outils Dessin. Au fur et à mesure que vous faites glisser la souris, le rectangle se dessine
jusqu’à la position du curseur.

Les carrés sont des rectangles dont les côtés sont de même longueur. Pour dessiner un carré, cli-
quez sur l’icône Rectangle  et gardez appuyée la touche Maj pendant que vous faites glisser la
souris.

Remarque

Ceci est le comportement par défaut de la touche Maj. Cependant, si l’option Lors de la 
création ou du déplacement des objets de la section Contraindre les objets est cochée 
dans la page LibreOffice Draw – Grille de la boîte de dialogue Options (Outils > Options 
dans la barre de menu), l’action de la touche Maj est inversée. Des carrés seront tracés, à 
moins que la touche Maj ne soit appuyée pour dessiner des rectangles.

Pour dessiner un rectangle ou un carré à partir de son centre, positionnez le curseur dans votre 
document, cliquez sur le bouton de la souris et gardez appuyée la touche Alt pendant que vous 
faites glisser le curseur. Le rectangle ou le carré utilisera la position de départ (l’endroit où vous 
avez cliqué en premier sur le bouton de la souris), comme centre.

Une fois un rectangle ou un carré sélectionné, vous pouvez modifier rapidement le style, la largeur 
et la couleur de la bordure, ainsi que le type et la couleur de remplissage, en utilisant les outils de 
la barre d’outils Ligne et remplissage ou de la page Propriétés du volet latéral. Vous pouvez égale-
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ment utiliser les commandes du menu contextuel (après un clic droit) ou du menu Format. Voir le 
chapitre 4, Modifier les attributs d’un objet du Guide Draw pour plus d’informations.

Dessiner des ellipses ou des cercles

Pour dessiner une ellipse (un ovale), cliquez sur l’icône Ellipse  de la barre d’outils Dessin. Au 
fur et à mesure que vous faites glisser la souris, l’ellipse se dessine à l’intérieur du rectangle allant 
jusqu’à la position du curseur.

Les cercles sont des ellipses dont les axes sont de même longueur. Pour dessiner un cercle, cli-
quez sur l’icône Ellipse  et gardez appuyée la touche Maj pendant que vous faites glisser la 
souris.

Remarque

Ceci est le comportement par défaut de la touche Maj. Cependant, si l’option Lors de la 
création ou du déplacement des objets de la section Contraindre les objets est cochée 
dans la page LibreOffice Draw – Grille de la boîte de dialogue Options (Outils > Options 
dans la barre de menu), l’action de la touche Maj est inversée. Des cercles seront tracés, à 
moins que la touche Maj ne soit appuyée pour dessiner des ellipses.

Pour dessiner une ellipse ou un cercle à partir de son centre, positionnez le curseur dans votre do-
cument, cliquez sur le bouton de la souris et gardez appuyée la touche Alt pendant que vous 
faites glisser le curseur. L’ellipse ou le cercle utilisera la position de départ (l’endroit où vous avez 
cliqué en premier), comme centre.

Une fois une ellipse ou un cercle sélectionné, vous pouvez modifier rapidement le style, la largeur 
et la couleur de la bordure, ainsi que le type et la couleur de remplissage, en utilisant les outils de 
la barre d’outils Ligne et remplissage. Vous pouvez également utiliser les commandes du menu 
contextuel (après un clic droit) ou du menu Format. Voir le chapitre 4, Modifier les attributs d’un 
objet du Guide Draw pour plus d’informations.

Remarque

Si vous appuyez sur la touche Ctrl et que vous la maintenez enfoncée en cliquant sur 
l’icône Ligne, Rectangle, Ellipse ou Texte, l’objet correspondant est automatiquement des-
siné au centre de l’espace de travail en utilisant les valeurs par défaut. Ces attributs peuvent
être modifiés par la suite si désirés. Voyez le Guide Draw pour plus d’informations.

Dessiner des courbes et des polygones

Pour dessiner une courbe ou un polygone, cliquez sur l’icône Courbe  de la barre d’outils Des-
sin. Cliquez sur le petit triangle à droite de l’icône pour accéder aux outils disponibles (Figure 14). 
L’icône du dernier outil utilisé apparaît dans la barre d’outils Dessin pour faciliter sa réutilisation.

Quand vous déplacez le pointeur de la souris au-dessus des icônes de la palette d’outils, une info-
bulle vous indique sa fonction.

Figure 14 : La barre d’outils Lignes
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Remarques

Si vous placez le curseur de la souris au-dessus de l’icône, l’infobulle vous indique le terme 
Courbe. Si vous détachez la barre d’outils, le titre est Lignes (Figure 14).

Appuyer sur la touche Maj en traçant les lignes avec les outils Courbe ou Polygone limite 
les angles entre ces lignes à 45 ou 90 °.

Courbes

Sélectionnez l’outil Courbe dans la palette ( ). Cliquez pour créer le point de départ de la 
courbe, puis, tout en gardant le bouton de la souris appuyé, faites glisser le curseur pour tracer 
une ligne droite à partir de ce point de départ. Relâchez le bouton gauche de la souris et déplacez 
le curseur pour infléchir la ligne droite en une courbe. Cliquez pour fixer la courbe dans la page. 
Vous pouvez continuer votre ligne en déplaçant le curseur de la souris et en cliquant pour fixer le 
point d’angle suivant ; vous pouvez infléchir la ligne obtenue en gardant le bouton gauche de la 
souris appuyé et en le faisant glisser jusqu’à obtenir ce que vous désirez. Pour terminer la courbe, 
faites un double-clic.

Une courbe remplie ( ) joint automatiquement le dernier point de la courbe avec son point de dé-
part, pour la refermer et la remplir avec la couleur standard. Une courbe non remplie n’est pas re-
fermée à la fin du tracé.

Polygones

Sélectionnez l’outil Polygone dans la palette ( ). Cliquez pour créer le point de départ du poly-
gone, puis, tout en gardant le bouton de la souris appuyé, faites glisser le curseur pour tracer la 
première ligne. Déplacez le curseur pour dessiner la ligne suivante. Chaque clic de souris va dé-
terminer un point d’angle et vous permet de dessiner une autre ligne. Un double-clic termine le po-
lygone.

Un polygone rempli ( ) joint automatiquement le dernier point d’angle avec son point de départ, 
pour le refermer et le remplir avec la couleur standard. Un polygone non rempli n’est pas refermé à
la fin du tracé.

Remarque

Si vous gardez appuyée la touche Maj durant le tracé d’une courbe ou d’un polygone, les 
angles seront limités aux multiples de 45 degrés.

Polygones à 45 °

Les polygones à 45 ° ( ) se tracent comme les autres polygones, mais les angles entre les lignes
sont limités aux multiples de 45 degrés. Par contre, si le polygone à 45 ° est fermé ( ), la ligne 
tracée automatiquement pour refermer la figure peut former des angles non multiples de 45 de-
grés.

Lignes à main levée

L’utilisation de l’outil Ligne à main levée ( ) est similaire au dessin sur un papier avec un crayon. 
Cliquez et gardez appuyé le bouton gauche de la souris, et faites glisser le curseur pour dessiner 
la ligne que vous voulez. Pour terminer la ligne, relâchez simplement le bouton : il n’est pas néces-
saire de double-cliquer.
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Une ligne à main levée remplie ( ) est automatiquement complétée par une ligne droite entre le 
point d’arrivée et le point de départ, et l’objet est rempli avec la couleur standard.

Ajouter du texte

Pour activer l’outil Texte, cliquez sur l’icône Texte  pour des textes horizontaux ou sur l’icône 
Texte vertical  pour écrire verticalement. L’icône Texte vertical n’est disponible que si l’option 
Asiatique est cochée dans la section Langues par défaut des documents de la page Paramètres
linguistiques – Langue dans la boîte de dialogue Option (Outils > Options dans la barre de 
menu). Vous pouvez utiliser la barre d’outils Formatage du texte (Affichage > Barres d’outils) ou 
le panneau Caractère dans la page Propriétés du volet latéral pour sélectionner la police, la taille 
de caractère et d’autres propriétés de texte avant de commencer à taper votre texte.

Après avoir cliqué sur l’icône Texte, cliquez à l’endroit où vous voulez faire apparaître le texte. Un 
petit cadre de texte apparaît, ne contenant que le curseur. Ce cadre peut être déplacé comme tout 
objet. Un cadre de texte est également dynamique et grandit lorsque vous tapez le texte.

Observez le champ d’information de la barre d’état : il indique que vous éditez un texte et fournit 
également des détails sur la position du curseur (numéro de paragraphe, de ligne et de colonne, 
voir Figure 15).

Figure 15 : Information sur un texte dans la barre d’état

Vous pouvez insérer un retour à la ligne avec la combinaison Maj+Entrée ou démarrer un nou-
veau paragraphe avec la touche Entrée. L’insertion de retours à la ligne ou de nouveaux para-
graphes ne termine pas l’édition du texte ni ne désélectionne le cadre de texte. Lorsque vous avez 
fini de taper le texte, cliquez à l’extérieur du cadre de texte ou appuyez sur la touche Échap.

Si vous voulez éditer le texte, cliquez sur le texte pour afficher la barre d’outils Formatage du texte 
et activer le curseur dans le texte.

Les propriétés du texte peuvent aussi être modifiées lors de la saisie du texte : les changements 
prendront effet à partir de la position du curseur. Pour modifier les propriétés de tout ou partie du 
texte, vous devez sélectionner ce texte dans le cadre avant de modifier ses propriétés.

Vous pouvez créer des styles de dessins que vous pourrez réutiliser pour d’autres cadres de texte.
Sélectionnez le menu Format > Styles et formatage, appuyez sur F11 ou cliquez sur l’icône 

Styles et formatage  pour afficher l’onglet correspondant du volet latéral. Les styles de dessins
affectent tout le texte d’un cadre de texte. Pour ne formater qu’une partie du texte, il faut utiliser le 
formatage direct à l’aide de la barre d’outils ou les panneaux Caractère et Paragraphe de la page 
Propriétés du volet latéral.

Les cadres de texte peuvent également avoir un remplissage, une ombre ou d’autres attributs 
exactement comme n’importe quel autre objet de Draw. Vous pouvez faire pivoter le cadre pour 
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écrire selon n’importe quel angle. Ces options sont disponibles par le menu contextuel accessible 
via le clic droit sur le cadre de texte.

Si vous faites un double-clic sur un objet, ou appuyez sur F2 ou cliquez sur l’icône Texte lorsqu’un 
objet est sélectionné, vous pouvez ajouter du texte à l’objet graphique. Ce texte fait alors partie de 
l’objet graphique. Par défaut, un objet graphique ne modifie pas sa taille lorsque vous saisissez le 
texte comme un cadre de texte. Pour maintenir le texte à l’intérieur des bordures de l’objet, vous 
devrez utiliser des paragraphes, des retours à la ligne, choisir un texte plus petit, agrandir la taille 
de l’objet, ou bien encore combiner les quatre méthodes.

Pour plus d’informations sur la gestion du texte dans Draw, référez-vous au Guide Draw, chapitre 
2, Dessiner des formes élémentaires et chapitre 9, Ajouter et formater des textes.

Points de collage et connecteurs

Points de collage

Tous les objets Draw ont des points de collage, qui ordinairement ne sont pas affichés. Les points 
de collage deviennent visibles quand l’icône Connecteur  est sélectionnée dans la barre d’ou-
tils Dessin ou la section Connecteurs de l’onglet Formes du volet latéral.

+

+

+ +

Figure 16 : Points de collage après sélection d’un outil Connecteur

La plupart des objets ont quatre points de collage (Figure 16). Vous pouvez ajouter et personnali-
ser des points de collage avec la barre d’outils Points de collage (Figure 17). Sélectionnez Affi-
chage > Barres d’outils > Points de collage pour la faire apparaître.

Les points de collage ne sont pas les poignées de sélection d’un objet. Les poignées de sélection 
servent à modifier la forme d’un objet, comme décrit chapitre 3, Manipuler les objets et les points 
des objets, du Guide Draw. Les points de collage servent à relier un connecteur à un objet afin 
que, quand l’objet est déplacé, le connecteur reste relié. Pour plus d’information sur les points de 
collage, voir le chapitre 8, Connecteurs et organigrammes, du Guide Draw.

Figure 17 : La barre d’outils Points de collage

Connecteurs

Les connecteurs sont des lignes ou des flèches dont les extrémités sont fixées à un point de col-
lage d’un objet. Ils sont très utiles pour dessiner des organigrammes, des diagrammes de flux et 
des cartes heuristiques. Lorsque les objets sont déplacés ou réordonnés, les connecteurs restent 
fixés à un point de collage. La Figure 18 montre l’exemple de deux objets reliés par un connecteur.
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Figure 18 : Deux objets reliés par un connecteur

Draw dispose de plusieurs connecteurs et fonctions de connexion (voir Figure 19). Cliquez sur le 
petit triangle à droite de l’icône Connecteur  pour ouvrir la barre d’outils Connecteurs. Pour une
description plus détaillée de l’utilisation des connecteurs, voir le chapitre 8, Connecteurs et organi-
grammes, du Guide Draw.

Figure 19 : La barre d’outils Connecteurs

Dessiner des formes géométriques

Les icônes pour dessiner des formes géométriques se situent dans la barre d’outils Dessin. Cli-
quez sur le petit triangle à droite de chaque icône pour ouvrir la palette d’outils correspondante.

L’utilisation des outils pour dessiner des formes géométriques est similaire à celle de l’outil pour 
dessiner des rectangles et des carrés. Voir Dessiner des rectangles ou des carrés page 12 ou le
chapitre 2, Dessiner des formes élémentaires, du Guide Draw.

Remarque

Les icônes pour les formes géométriques dans la barre d’outils Dessin sont variables et 
changent selon le dernier outil sélectionné et utilisé pour dessiner un objet.

Formes de base

Cliquez sur le petit triangle à droite de l’icône Formes de base  pour ouvrir la barre d’outils 
Formes de base (Figure 20). Cette barre d’outils comprend des outils Rectangle et Ellipse iden-
tiques à ceux qui se trouvent dans la barre d’outils Dessin.

Figure 20 : Barre d’outils Formes de base

Formes des symboles

Cliquez sur le petit triangle à droite de l’icône Formes des symboles  pour ouvrir la barre d’ou-
tils Formes des symboles (Figure 21).
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Figure 21 : Barre d’outils Formes des symboles

Flèches pleines

Cliquez sur le petit triangle à droite de l’icône Flèches pleines  pour ouvrir la barre d’outils 
Flèches pleines (Figure 22).

Figure 22 : Barre d’outils Flèches pleines

Organigrammes

Cliquez sur le petit triangle à droite de l’icône Organigramme  pour ouvrir la barre d’outils Or-
ganigramme (Figure 23). La création des organigrammes, diagrammes de flux et autres outils simi-
laires est détaillée chapitre 8, Connecteurs et organigrammes, du Guide Draw.

Figure 23 : Barre d’outils Organigramme

Légendes

Cliquez sur le petit triangle à droite de l’icône Légendes  pour ouvrir la barre d’outils Légendes 
(Figure 24).

Figure 24 : Barre d’outils Légendes

Étoiles

Cliquez sur le petit triangle à droite de l’icône Étoiles  pour ouvrir la barre d’outils Étoiles et 
bannières (Figure 25).

Figure 25 : Barre d’outils Étoiles et bannières
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Remarque

Vous pouvez ajouter du texte à toutes ces formes comme indiqué à la section Ajouter du 
texte page 15 ou aux chapitres 2, Dessiner des formes élémentaires, et 11, Techniques 
avancés, du Guide Draw.

Dessiner successivement plusieurs formes

Vous pouvez dessiner successivement plusieurs formes, plusieurs lignes par exemple, sans avoir 
à sélectionner l’icône Ligne à chaque fois. Pour ceci, faites un double-clic sur l’icône de la forme 
que vous souhaitez dessiner. Tracez votre première forme. Vous pouvez remarquer que le pointeur
de la souris garde la même apparence et ne revient pas au symbole qu’il a lorsqu’il est un outil de 
sélection. Tracez les formes suivantes. Pour terminer, appuyez sur la touche Échap ou faites un 
clic simple dans le dessin.

Vous pouvez faire de même avec les formes géométriques. Mais il est nécessaire de détacher la 
barre d’outils correspondante avant de faire un double-clic sur la forme désirée.

Sélectionner des objets

Sélection directe

La façon la plus simple de sélectionner un objet est de cliquer directement dessus. Pour sélection-
ner un objet sans remplissage, cliquez sur sa bordure. Cliquez ailleurs dans le document pour dés-
électionner l’objet. Pour (dé)sélectionner plusieurs objets, gardez appuyée la touche Maj pendant 
que vous cliquez successivement sur chacun d’eux.

Sélection par encadrement

Vous pouvez également sélectionner plusieurs objets en cliquant et faisant glisser la souris autour 
d’eux. Un rectangle en pointillés se dessine et seuls les objets qui sont entièrement compris dans 
ce rectangle seront sélectionnés.

Pour sélectionner plusieurs objets par encadrement, l’icône Sélectionner  de la barre d’outils 
Dessin doit être active.

Sélectionner des objets cachés

Si des objets sont cachés derrière d’autres objets et ne sont donc pas visibles, vous pouvez quand
même les sélectionner. Gardez appuyée la touche Alt et sélectionnez l’objet derrière lequel l’objet
caché est situé, puis cliquez à nouveau pour sélectionner l’objet caché. S’il y a plusieurs niveaux 
d’objets cachés, gardez appuyée la touche Alt et cliquez jusqu’à ce que vous atteigniez l’objet 
que vous désirez. Pour parcourir les objets empilés dans l’ordre inverse, gardez appuyées les 
touches Maj+Alt et cliquez.

Lorsque vous cliquez sur l’objet caché, son contour apparaît brièvement à travers l’objet qui le re-
couvre.

Cette méthode implique que vous sachiez précisément à quel endroit se trouvent les objets ca-
chés. Si vous cliquez sur l’objet visible, mais à côté d’un objet caché, rien ne se passe. Une autre 
méthode peut être alors préférable.
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Remarque

La méthode utilisant la touche Alt ne fonctionne pas que sur les ordinateurs ayant Win-
dows ou macOs comme système d’exploitation. Sur un ordinateur utilisant le système d’ex-
ploitation Linux, il faut utiliser la méthode avec la touche Tabulation décrite ci-dessous.

Une autre méthode consiste à utiliser la touche Tabulation pour parcourir le cycle des objets 
existants et de vous arrêter sur l’objet que vous voulez sélectionner. Pour parcourir le cycle dans 
l’ordre inverse, appuyez sur Maj+Tabulation. La rapidité de cette méthode dépend du nombre 
d’objets se trouvant dans votre dessin.

Une troisième méthode consiste à nommer les objets que vous créez et d’y accéder avec le navi-
gateur, en parcourant l’arborescence des objets des diapositives et en double-cliquant sur l’objet 
que vous voulez sélectionner.

Disposer les objets

Dans un dessin complexe, des objets peuvent être empilés l’un sur l’autre. Pour modifier l’ordre de
l’empilement en déplaçant les objets vers l’avant ou vers l’arrière, sélectionnez un objet, choisissez
Modifier > Disposition dans la barre de menus et choisissez l’une des actions disponibles, 
comme Envoyer vers l’avant ou Envoyer vers l’arrière. Vous pouvez également faire un clic 
droit sur l’objet et utiliser les actions de l’option Organiser du menu contextuel.

Les actions de Modifier > Disposition sont également accessibles à partir de l’icône Disposer 
de la barre d’outils Standard. Vous pouvez alors afficher la barre d’outils Position qui donne accès 
aux différentes options de disposition (Figure 26).

Figure 26 : La barre d’outils Position

Déplacer et ajuster la taille d’un objet

Lorsque vous déplacez ou modifiez la taille d’un objet, vérifiez la partie gauche de la barre d’état 
en bas de la fenêtre de Draw (Figure 27). La barre d’état indique, dans son deuxième champ, le 
type d’objet sélectionné, et, dans le quatrième, sa position dans le dessin en coordonnées X/Y et 
ses dimensions. L’unité de mesure est celle sélectionnée dans le menu dans la page LibreOffice 
Draw – Général de la boîte de dialogue Options (Outils > Options).

Opération en cours

Coordonnées du coin supérieur gauche

Dimensions

Figure 27 : Extrémité gauche de la barre d’état quand un objet est sélectionné
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Pour plus d’informations sur le déplacement et l’ajustement de la taille, reportez-vous au Chapitre 
3, Manipuler les objets et les points des objets du Guide Draw.

Déplacer des objets

Pour déplacer un objet (ou un groupe d’objets), sélectionnez-le et positionnez le curseur de la sou-
ris au-dessus pour qu’il prenne la forme du curseur de déplacement (habituellement la quadruple 
flèche) ; puis cliquez et faites glisser jusqu’à la position désirée. Durant le déplacement, une image
fantôme de l’objet apparaît pour aider à son positionnement (Figure 28). Relâcher le bouton de la 
souris pour attribuer son nouvel emplacement à l’objet.

Figure 28 : Déplacer un objet

Modifier la taille des objets

Pour modifier la taille de l’objet sélectionné (ou du groupe d’objets sélectionnés), déplacez le cur-
seur de la souris au-dessus d’une des poignées de sélection. Le curseur change de forme pour 
vous indiquer la direction du mouvement correspondant. Cliquez et faites glisser jusqu’à atteindre 
la taille désirée. Au fur et à mesure du changement de taille, une image fantôme du nouvel objet 
apparaît pour vous aider (Figure 29).

Le résultat dépend de la poignée de sélection choisie. Utilisez une poignée de côté pour redimen-
sionner un objet selon un seul axe. Utilisez une poignée de coin pour le redimensionner selon les 
deux axes.

Figure 29 : Modifier la taille d’un objet
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Remarque

Si vous gardez appuyée la touche Maj durant le redimensionnement d’un objet, la propor-
tion entre hauteur et largeur sera conservée, afin que le rapport d’aspect de l’objet reste in-
changé. Ce comportement s’applique à toutes les poignées.

Ceci est le comportement par défaut de la touche Maj. Cependant, si l’option Lors de la 
création ou du déplacement des objets de la section Contraindre les objets est cochée 
dans la page LibreOffice Draw – Grille de la boîte de dialogue Options (Outils > Options 
dans la barre de menu), l’action de la touche Maj est inversée. La proportion entre hauteur 
et largeur sera automatiquement conservée, à moins que la touche Maj ne soit appuyée.

Boîte de dialogue Position et taille

Pour ajuster de façon plus précise la taille ou la position d’un objet, il peut être préférable d’utiliser 
la boite de dialogue Position et taille :

• sélectionner Format > Position et taille dans la barre de menus ;

• faire un clic droit et choisir Position et taille dans le menu contextuel ;

• appuyer sur la touche F4.

Pour plus d’informations sur l’utilisation de cette boite de dialogue, reportez-vous au Chapitre 3 
Manipuler les objets et les points des objets du Guide Draw.

Pivoter et incliner des objets

Pour plus d’informations sur la rotation et l’inclinaison des objets, reportez-vous au chapitre 3, Ma-
nipuler les objets et les points des objets, du Guide Draw.

Faire pivoter un objet

Pour faire effectuer une rotation à un objet (ou à un groupe d’objets), sélectionnez-le, puis passez 
en mode rotation

• en cliquant sur l’outil Transformation de la barre d’outils Standard quand il affiche l’icône Pi-
voter ( ) ;

• en cliquant sur cette icône ( ) dans la barre d’outils Transformations (Affichage > Barres 
d’outils > Transformations dans la barre de menu), ou dans la palette de transformations, 
qui s’ouvre grâce à la petite flèche à la droite de l’outil ;

• en cliquant sur un objet déjà sélectionné, celui-ci passe en mode rotation/inclinaison. Un clic 
supplémentaire le ramène en mode déplacement/redimensionnement.

Les poignées de sélection changent de forme et de couleur (Figure 30). Le centre de rotation ap-
paraît également au milieu de l’objet. Déplacez le curseur de la souris au-dessus d’une des poi-
gnées : sa forme change. Les poignées de coin servent à faire effectuer une rotation à l’objet, tan-
dis que les poignées de côté servent à l’incliner.
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Figure 30 : Faire effectuer une rotation à un objet

Déplacez le curseur de la souris au-dessus d’une des poignées de coin. Le curseur prend norma-
lement la forme d’un arc. Cliquez et faites glisser pour faire tourner l’objet. Au fur et à mesure de la
rotation, une image fantôme du nouvel objet apparaît pour vous aider.

Vous trouverez également des informations dans la barre d’état, comme le montre la Figure 30. La
zone d’information vous indique que vous faites tourner un objet et l’angle de rotation. Les 
nombres indiquant la position et la taille s’actualisent au cours de la rotation.

Remarque

La rotation des objets 3D fonctionne de manière assez différente, étant donné qu’elle s’ef-
fectue dans un espace à trois dimensions et non dans un plan simple. Voir le chapitre 7, 
Manipuler des objets 3D, du Guide Draw pour plus d’informations.

Le centre de rotation se situe habituellement au centre de l’objet. Pour modifier sa position, cliquez
sur le centre de rotation et faites-le glisser jusqu’à l’emplacement désiré. Le centre de rotation peut
se situer à l’extérieur de l’objet.

Remarque

Si vous gardez appuyée la touche Maj durant la rotation d’un objet, l’angle de rotation est li-
mité aux multiples de 15 degrés.

Ceci est le comportement par défaut de la touche Maj. Cependant, si l’option Lors de la 
création ou du déplacement des objets de la section Contraindre les objets est cochée 
dans la page LibreOffice Draw – Grille de la boîte de dialogue Options (Outils > Options 
dans la barre de menu), l’action de la touche Maj est inversée. L’angle de rotation est limité 
aux multiples de 15 degrés (valeur par défaut), à moins que la touche Maj ne soit appuyée.

Incliner un objet

Pour incliner un objet (ou un groupe d’objets), sélectionnez-le, puis passez en mode rotation en 
sélectionnant l’outil Pivoter  dans la barre d’outils Ligne et remplissage.

Les poignées de sélection changent de forme et de couleur (Figure 31). Déplacez le curseur de la 
souris au-dessus d’une des poignées : sa forme change. Les poignées de coin servent à faire ef-
fectuer une rotation à l’objet, tandis que les poignées de côté servent à l’incliner.
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Figure 31 : Incliner un objet

Déplacez le curseur de la souris au-dessus d’une des poignées de côté. Le curseur prend norma-
lement la forme de deux demi-flèches inversées. Si vous utilisez les poignées en haut ou en bas, 
l’axe utilisé pour l’inclinaison est le côté opposé à celui de la poignée que vous cliquez. Cet axe 
reste fixe, tandis que les autres côtés bougent en fonction du curseur de la souris que vous faites 
glisser. Au fur et à mesure de l’inclinaison, une image fantôme du nouvel objet apparaît pour vous 
aider.

Vous trouverez également des informations dans la barre d’état, comme le montre la Figure 31. La
zone d’information vous indique que vous inclinez un objet et l’angle d’inclinaison. Les nombres in-
diquant la position et la taille s’actualisent au cours de la déformation.

Remarque

Si vous gardez appuyée la touche Maj durant l’inclinaison d’un objet, l’angle d’inclinaison 
est limité aux multiples de 15 degrés.

Ceci est le comportement par défaut de la touche Maj. Cependant, si l’option Lors de la 
création ou du déplacement des objets de la section Contraindre les objets est cochée 
dans la page LibreOffice Draw – Grille de la boîte de dialogue Options (Outils > Options 
dans la barre de menu), l’action de la touche Maj est inversée. L’angle de rotation est limité 
aux multiples de 15 degrés (valeur par défaut), à moins que la touche Maj ne soit appuyée.

Éditer et formater des objets

Pour éditer un objet ou modifier ses attributs, tels que la couleur, l’épaisseur de la bordure, etc., les
barres d’outils Ligne et remplissage, Formatage du texte, l’onglet Propriétés du volet latéral ou le 
menu contextuel peuvent être utilisés. Vous trouverez plus d’informations sur l’édition des objets et
la modification des attributs au chapitre 4, Modifier les attributs d’un objet du Guide Draw.

Barre d’outils Ligne et remplissage

Par défaut, la barre d’outils Ligne et remplissage (Figure 32) n’apparaît pas dans Draw. Pour l’affi-
cher, sélectionnez Affichage > Barres d’outils > Ligne et remplissage dans la barre de menu. 
Les attributs les plus usuels d’un objet peuvent être modifiés au moyen de cette barre d’outils. 
Vous pouvez accéder à des informations supplémentaires en cliquant sur l’icône Ligne  pour 
accéder à la boîte de dialogue Ligne, ou en cliquant sur l’icône Remplissage  pour accéder à la
boîte de dialogue Remplissage.
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Figure 32 : Barre d’outils Ligne et remplissage

Barre d’outils Formatage du texte

Vous pouvez ouvrir la barre d’outils Formatage du texte (Figure 33) en sélectionnant Affichage > 
Barres d’outils > Formatage du texte dans la barre de menus. Les outils de cette barre d’outils 
ne seront disponibles que lorsqu’un texte aura été sélectionné.

Les outils disponibles dans cette barre d’outils, de gauche à droite, sont listés Figure 33.

Figure 33 : Barre d’outils Formatage du texte

La page Propriétés du volet latéral

Quand vous sélectionnez un objet de votre dessin,
l’onglet Propriétés du volet latéral s’active (Figure 
34). Vous pouvez y modifier les propriétés ou op-
tions d’un objet sans devoir ouvrir de boite de dia-
logue ni utiliser un des outils disponibles dans les
diverses barres d’outils proposées par Draw. Pour
ouvrir un panneau, cliquez sur le signe plus (+ ou 
˅) près de son titre. L’onglet Propriétés propose les
propriétés principales. Pour accéder à toutes les
propriétés, cliquez sur l’icône  à droite du titre du
panneau : la boite de dialogue correspondant
s’ouvre directement sans passer par les menus.
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Menu contextuel d’un objet

Lorsque vous sélectionnez un objet et que
vous faites un clic droit, un menu contextuel
s’ouvre (Figure 35) et vous permet d’accéder
à des commandes destinées à modifier les at-
tributs de l’objet sélectionné. Les éléments du
menu qui comportent un petit triangle noir à
leur droite donnent accès à un sous-menu.

Formater des lignes et des bordures

Dans LibreOffice, le terme de ligne s’applique à un segment indépendant (ligne), au bord extérieur 
d’une forme (bordure) ou à une flèche. Dans la plupart des cas, les propriétés d’une ligne que vous
allez modifier sont son style (continu, tirets, pointillés, invisible…), sa largeur et sa couleur.

! Attention

L’outil Largeur permet de définir l’épaisseur du trait. Ne pas confondre avec la largeur (lon-
gueur du trait) définissable dans la boite de dialogue Position et taille.

Vous pouvez effectuer rapidement les modifications en sélectionnant la ligne et en utilisant les ou-
tils de la barre d’outils Ligne et remplissage (Figure 36).

Figure 36 : Style, largeur et couleur d’une ligne

Si vous avez besoin de régler plus finement les attributs d’une ligne, vous pouvez le faire dans la 
boîte de dialogue Ligne. Pour y accéder, sélectionner la ligne et choisissez Format > Ligne dans 
la barre de menus, cliquez sur l’icône Ligne  de la barre d’ou-
tils Ligne et remplissage, ou faites un clic droit et choisissez Ligne
dans le menu contextuel. La boîte de dialogue Ligne (Figure 10
page 10) comporte trois onglets : Ligne, Styles de lignes et Styles
de flèches. Vous pouvez aussi utiliser le panneau Ligne de la
page Propriétés du volet latéral (Figure 34) pour modifier l’appa-
rence d’une ligne.

Flèches, extrémités de flèches et de lignes

Les flèches, extrémités de flèches ou d’autres lignes sont rassem-
blées sous le terme de flèches et peuvent être traitées de la
même façon que les lignes lors de l’édition et de la modification
des attributs. Sélectionnez une ligne et cliquez sur l’icône Style
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de flèche  de la barre d’outils Ligne et remplissage pour ouvrir la liste déroulante Extrémités de 
flèche (Figure 37).

Plusieurs types d’extrémités de flèche sont disponibles. Chaque extrémité d’une ligne peut avoir 
un type différent ou aucun. Les extrémités de flèche ne sont applicables que pour les lignes et 
n’ont pas d’effet sur les bordures d’un objet.

Formater le remplissage

Le terme de remplissage fait référence à l’intérieur d’un objet, qui peut être d’une couleur uniforme,
en dégradé, avec un motif de hachure ou constitué d’une image bitmap (Figure 38). Le remplis-
sage d’un objet peut être partiellement ou totalement transparent et projeter une ombre.

Couleur

Dégradé

Hachures

Bitmap

Motif

Figure 38 : Différents types de remplissage

La barre d’outils Ligne et remplissage contient les outils les plus habituellement utilisés pour forma-
ter des objets ou dans la section Zone du panneau Propriétés du Volet latéral. Vous pouvez aussi 
définir vos propres types de remplissage.

Vous trouverez plus d’informations au chapitre 4, Modifier les attributs d’un objet, du Guide Draw, 
sur le formatage du remplissage.

Utiliser les styles

Supposez que vous vouliez appliquer le même remplissage et la même largeur de bordure et de 
ligne à un ensemble d’objets. Cette procédure répétitive peut être simplifiée par l’utilisation des 
styles. Cette fonctionnalité vous permet de définir un modèle de format (un style) et ensuite de 
l’appliquer à plusieurs objets. Pour plus d’informations sur les styles, voir le chapitre 8, Introduction
aux styles du Guide Writer et le chapitre 4, Modifier les attributs d’un objet du Guide Draw.

Positionner les objets

Fonction de capture

Dans Draw, les objets peuvent être positionnés avec précision en utilisant les fonctions de capture.
Les points de la grille, les points de capture, le cadre d’un objet, des points individuels d’un objet 
ou les bords de page peuvent tous être utilisés avec la fonction de capture.

La fonction de capture est plus facile à utiliser avec un zoom élevé qui convient à votre affichage. 
Deux fonctions de capture différentes peuvent être activées en même temps : par exemple la cap-
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ture aux lignes guide et au bord de page. Il est cependant recommandé de n’activer que les fonc-
tions nécessaires.

Pour plus d’informations sur la fonction de capture, reportez-vous aux chapitres 3 Manipuler les 
objets et les points des objets et 11 Techniques avancées du Guide Draw.

Capturer sur la grille

Capturer à la grille permet de positionner un objet sur un point de la grille (Figure 39). Sélectionnez
le menu Affichage > Grille et lignes guide > Aligner sur la grille ou cliquez sur l’icône Aligner 
sur la grille  de la barre d’outils Options (Figure 40) pour activer ou désactiver la capture à la 
grille. La barre d’outils Options s’affiche en sélectionnant le menu Affichage > Barre d’outils > 
Options.

Figure 39 : Positionnement avec la capture sur la grille

Figure 40 : Barre d’outils Options

Afficher la grille

Pour afficher la grille ou la masquer, sélectionnez le menu Affichage > Grille et lignes guide > 
Afficher la grille ou cliquez sur l’icône Afficher la grille  de la barre d’outils Options.

Configurer la grille

La résolution, la capture et la position de capture des points de la grille peuvent être configurées. 
Sélectionnez Outils > Options dans la barre de menu pour ouvrir la boîte de dialogue Options 
puis ouvrez la page LibreOffice Draw – Grille où se trouvent les réglages de la grille (Figure 41).

• Espacement vertical et horizontal des points de la grille. Vous pouvez également modifier 
l’unité de mesure utilisée à l’aide des options de Draw dans la page LibreOffice Draw – Gé-
néral.

• La résolution est la taille des carrés ou rectangles de la grille. Si la résolution est de 1 cm ho-
rizontal et 2 cm vertical, la grille sera constituée de rectangles de 2 cm de haut et 1 cm de 
large.

28 | Débuter avec Draw



• La subdivision définit le nombre de points supplémentaires qui apparaissent sur les côtés de 
chaque rectangle ou carré de la grille. Les objets s’alignent aussi bien sur ces subdivisions 
que sur les sommets de la grille.

• La couleur par défaut de la grille est gris clair. Pour changer la couleur des points de la grille, 
ouvrez la page LibreOffice – Couleurs de l’interface.

La plage de capture définit la distance à laquelle vous devez approcher un objet pour qu’il soit cap-
turé par la ligne ou le point.

Figure 41 : Options de la grille

Lignes d’aide

Les lignes d’aide lors du déplacement sont une autre fonction de Draw qui vous aide à positionner 
des objets. Des lignes d’aide peuvent être affichées au cours du déplacement d’un objet. Elles 
étendent les bords de l’objet jusqu’aux règles (activables avec le menu Affichage > Règles), et 
n’ont aucune fonction de capture (Figure 42).

Figure 42 : Lignes d’aide
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Pour activer et désactiver l’affichage des lignes d’aide ouvrez la boîte de dialogue Options (Outils 
> Options dans la barre de menu) à la page LibreOffice Draw – Affichage et cochez ou décochez 
l’option Capturer aux lignes lors du déplacement ou utilisez l’icône Lignes d’aide lors du dé-
placement  de la barre d’outils Options (Figure 40).

Appliquer des effets spéciaux

Un certain nombre d’effets spéciaux peuvent être appliqués à un objet ou un groupe d’objets dans 
Draw. Cette section est une introduction à certains de ces effets. Pour plus d’informations sur les 
effets spéciaux, voyez le chapitre 4, Modifier les attributs d’un objet, du Guide Draw.

Plusieurs d’entre eux sont disponibles dans la barre d’outils Transformations (Figure 43) acces-
sible depuis la barre d’outils Ligne et formatage. Si cette barre d’outils n’est pas visible, sélection-
nez Affichage > Barre d’outils > Transformations. Pivoter et Retourner sont aussi accessibles 
dans l’entrée Modifier de la barre de menu et Retourner dans le menu contextuel des objets.

Figure 43 : Barre d’outils Transformations

Pour les informations sur la rotation des objets, voir Pivoter et incliner des objets page 22. Pour 
les informations sur la révolution des objets en 3D, voir le chapitre 7, Manipuler des objets 3D du 
Guide Draw.

Retourner des objets

La méthode la plus simple et la plus rapide pour retourner un objet verticalement ou horizontale-
ment est de sélectionner l’objet et de cliquer sur le bouton adéquat  ou  dans le panneau Po-
sition et taille de l’onglet Propriétés du volet latéral. Il est aussi possible de faire un clic droit sur 
l’objet à refléter et de sélectionner dans le menu contextuel Retourner > Verticalement ou Hori-
zontalement. La commande est également accessible dans le menu Modifier > Retourner > Ver-
ticalement ou Horizontalement.

L’outil Retourner  de la barre d’outils Transformations permet cependant un contrôle plus fin de 
l’effet en autorisant la modification de la position et de l’angle de l’axe de retournement de l’objet. 
Son utilisation est décrite au chapitre 4, Modifier les attributs d’un objet du Guide Draw.

Copies miroir

Il n’y a pas de commande miroir dans Draw. Cependant, l’effet miroir peut être émulé en utilisant 
l’outil Retourner comme décrit au chapitre 4, Modifier les attributs d’un objet du Guide Draw.

Déformer un objet

Trois outils de la barre d’outils Mode permettent de faire glisser les coins et les bords d’un objet 
pour déformer sa représentation :

• Positionner sur le cercle (en perspective)  : crée un pseudo-effet 3D ;

• Positionner sur le cercle (incliner)  : crée un pseudo-effet 3D ;

• Déformer  : déforme un objet en perspective.
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Dans les trois cas, il vous est demandé si vous voulez transformer l’objet en courbe (sauf si l’objet 
a déjà été transformé). Cette première étape est irréversible mais nécessaire, donc cliquez sur 
Oui. Vous pouvez ensuite déplacer les poignées de l’objet (qui sont devenues bleues) pour obtenir
l’effet désiré. Reportez-vous au Chapitre 4 Modifier les attributs d’un objet du Guide Draw pour 
plus d’informations sur la déformation des objets.

Gradients de transparence dynamiques

Vous pouvez contrôler les gradients de transparence de la même façon que les gradients de cou-
leur. Les deux types de gradient peuvent être utilisés simultanément. Avec un gradient de transpa-
rence, la direction et le degré de couleur de remplissage de l’objet changent depuis opaque jus-
qu’à transparent. Dans un gradient de couleurs (dégradé) le remplissage change d’une couleur à 
une autre, mais le degré de transparence reste le même.

Il est nécessaire de transformer un objet en courbe, polygone ou contour avant de lui appliquer un 
gradient de transparence.

Les outils Transparence et Dégradé de la barre d’outils Transformations contrôlent dynamique-
ment le gradient de transparence ou couleur. Reportez-vous au chapitre 4, Modifier les attributs 
d’un objet, du Guide Draw pour plus d’informations sur la création de transparence et de dégradé 
dans un objet.

Dupliquer

L’outil Dupliquer crée des copies de l’objet en même temps qu’un ensemble de transformations est
appliqué à chaque copie, comme la couleur ou la rotation.

 1) Cliquez sur un objet ou un groupe d’objets et sélectionnez le menu Édition > Dupliquer, ou 
utilisez le raccourci clavier Maj+F3 pour ouvrir la boîte de dialogue Dupliquer (Figure 44).

Figure 44: Boîte de dialogue Dupliquer

 2) Sélectionnez les options requises :

─ le nombre de copies à créer ;

─ le décalage entre chaque copie en abscisse, ordonnée et la rotation à effectuer ;
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─ la modification de taille entre chaque copie ;

─ la modification de couleur entre l’original et la dernière copie.

Par exemple, si les options de la Figure 44 sont appliquées à un rectangle, le résultat obtenu est 
affiché sur la Figure 45.

Figure 45: Exemple d’application de Dupliquer

Fondu enchaîné

Le fondu enchaîné transforme la forme d’un objet en une autre forme. Il ne fonctionne que lorsque 
deux objets sont sélectionnés :

 1) Sélectionnez deux objets de formes différentes.

 2) Sélectionnez le menu Édition > Fondu enchaîné pour ouvrir la boîte de dialogue Fondu en-
chaîné (Figure 46).

 3) Ajustez Incréments pour définir le nombre de formes entre les deux objets.

 4) Cochez Attributs du fondu enchaîné pour appliquer un changement graduel des propriétés
de remplissage et de lignes entre les objets.

 5) Cochez Même orientation pour adoucir la transition entre les objets.

 6) Validez par OK.

Figure 46: Boîte de dialogue Fondu enchaîné

Le résultat des paramètres de la Figure 46 est présenté sur la Figure 47 pour un carré et une croix.

Figure 47: Exemple de Fondu enchaîné
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Combiner plusieurs objets

Dans Draw, vous pouvez grouper ou combiner des objets ensemble ce qui vous permet de les trai-
ter comme un objet unique ou de les fusionner les objets pour créer une nouvelle forme. Vous trou-
verez plus d’informations au chapitre 5, Combiner plusieurs objets, du Guide Draw.

Quand vous groupez plusieurs objets, vous pouvez les considérer comme placés dans un conte-
neur. Vous pouvez alors les déplacer tous ensemble et leur appliquer des modifications globales. 
Un groupe peut toujours être défait et les objets qui le constituent peuvent toujours être manipulés 
séparément. Ils disposent chacun de leurs propres caractéristiques.

Quand vous combinez plusieurs objets, ils sont fusionnés de façon permanente en un nouvel ob-
jet. Les objets d’origine ne sont plus disponibles en tant qu’entités individuelles et ne peuvent plus 
être édités individuellement. Toute édition d’un objet combiné s’applique à tous les objets utilisés 
lors de l’opération de combinaison.

Grouper

Créer un groupement temporaire

Des objets sont groupés temporairement lorsqu’ils sont sélectionnés grâce à l’outil Sélection ( ) 
de la barre d’outils Dessin ou en encadrant les objets dans un rectangle grâce à la souris. Toutes 
les modifications des paramètres que vous effectuez sont appliquées à tous les objets à l’intérieur 
de ce groupe temporaire. Par exemple, vous pouvez modifier la couleur de remplissage de tous 
les objets d’un groupe temporaire en une seule fois ou lui faire effectuer une rotation dans sa glo-
balité.

Pour supprimer un groupement temporaire, cliquez simplement à l’extérieur des poignées de sé-
lection qui s’affichent autour des objets.

Créer un groupement permanent

Pour grouper des objets de façon permanente, commencez par les sélectionner. Faites un clic 
droit à l’intérieur d’un des objets du groupe et choisissez Grouper dans le menu contextuel. Vous 
pouvez également choisir Modifier > Grouper depuis la barre de menus ou utiliser le raccourci 
clavier Ctrl+Maj+G. Si vous cliquez à l’extérieur de la sélection, les objets restent groupés.

Une fois que les objets sont groupés, toute opération d’édition que vous allez effectuer sur ce 
groupe va s’appliquer à chacun des objets qui le composent. Si vous cliquez sur l’un des objets du 
groupe, le groupe entier est sélectionné.

Les objets à l’intérieur d’un groupe conservent leurs propres propriétés individuelles et peuvent 
être édités séparément sans briser le groupe. Pour cela, faites un clic droit à l’intérieur d’un des 
objets du groupe et choisissez Entrer dans le groupe dans le menu contextuel. Vous pouvez éga-
lement sélectionner le groupe et appuyer sur la touche F3 ou faire un double-clic à l’intérieur d’un 
objet ou sélectionner le menu Modifier > Entrer dans le groupe.

Pour quitter un groupe, faites un clic droit à l’intérieur du groupe et choisissez Quitter le groupe 
dans le menu contextuel. Vous pouvez également choisir Modifier > Quitter le groupe dans la 
barre de menu, appuyer sur les touches Ctrl+F3 ou faire un double-clic à l’extérieur du groupe.
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Dissocier un groupement permanent

Pour défaire ou dissocier un groupe d’objets, faites un clic droit à l’intérieur d’un des objets du 
groupe et choisissez Dissocier dans le menu contextuel. Vous pouvez également choisir Modifier
> Dissocier depuis la barre de menus ou utiliser le raccourci clavier Ctrl+Alt+Maj+G.

Combiner des objets

Combiner des objets revient à les fusionner de façon permanente pour créer un nouvel objet. Les 
objets d’origine ne sont plus disponibles en tant qu’entités propres et ne peuvent plus être modifiés
individuellement. Toute modification d’un objet combiné affecte tous les objets qui ont été utilisés 
pour créer la combinaison.

Sélectionnez les objets que vous voulez combiner, puis sélectionnez faites un clic droit à l’intérieur 
d’un des objets du groupe et choisissez Combiner dans le sous-menu Formes du menu contex-
tuel. Vous pouvez également choisir Modifier > Combiner depuis la barre de menus ou utiliser le 
raccourci clavier Ctrl+Maj+K.

Après avoir sélectionné les objets, les commandes Fusionner, Soustraire et Intersecter sont 
également disponibles par le menu Modifier > Formes ou le sous-menu Formes du menu contex-
tuel. Vous trouverez plus d’informations sur ces fonctions au chapitre 5, Combiner plusieurs objets,
du Guide Draw.

Positionner des objets

Dans Draw, vous pouvez disposer, aligner et répartir les objets sélectionnés les uns par rapport 
aux autres :

• disposer un objet en le déplaçant vers l’avant ou vers l’arrière en fonction de l’ordre des ob-
jets ;

• aligner les objets les uns par rapport aux autres en utilisant un alignement À gauche, Centré
ou À droite à l’horizontal et En haut, Centre ou En bas à la verticale ;

• répartir les objets de telle sorte que l’espace entre les objets soit le même.

Vous trouverez plus d’informations sur ces fonctions au chapitre 5, Combiner plusieurs objets, du 
Guide Draw.

Insérer et éditer des images

Même si Draw a des outils très poussés pour l’édition d’images vectorielles, il dispose également 
d’un certain nombre de fonctions pour traiter des images matricielles (bitmaps : images par point), 
par exemple des photos ou des images scannées. Cela inclut l’importation et l’exportation 
d’images et la conversion d’un format dans un autre.

Draw inclut une grande gamme de filtres graphiques qui lui permettent de lire et d’afficher de nom-
breux formats de fichier image. Il contient également plusieurs outils pour travailler avec des 
images matricielles, mais ne dispose pas des mêmes fonctionnalités que des programmes spécia-
lisés pour le traitement des images, tels que Gimp ou Adobe Photoshop. Veuillez vous reporter au 
chapitre 6, Éditer des images du Guide Draw pour plus d’informations.

Vous pouvez insérer des images à partir de plusieurs sources :
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• images créées par un autre programme, incluant des photos d’un appareil photo (Insertion >
Image) ;

• directement à partir d’un scanner (Insertion > Media > Scanner > Acquérir) ;

• à partir de la Galerie de LibreOffice ; voir le chapitre 11, Dessins, Gallery et Fontwork de ce 
guide pour plus d’informations.

Utiliser des objets 3D

Bien que Draw n’atteigne pas le niveau de fonctionnalités des programmes spécialisés dans l’édi-
tion de dessins et d’images, il est capable de produire et d’éditer de très bons dessins 3D.

Draw dispose de deux types d’objets 3D : des corps 3D et des formes 3D. Suivant le type choisi, il 
y a différentes méthodes d’édition d’un objet 3D (rotation, éclairage, perspective, etc.), les formes 
3D étant plus simples à construire et à éditer que les corps 3D. Cependant, ces derniers per-
mettent une plus grande paramétrisation.

Reportez-vous au chapitre 7, Manipuler des objets 3D, du Guide Draw pour plus d’informations.

Exporter des images

Draw enregistre les dessins et les images dans le format ouvert normalisé OpenDocument (*.odg).
Pour enregistrer un graphique ou un fichier entier dans un autre format, sélectionnez le menu Fi-
chier > Exporter et sélectionnez un format à partir de la liste affichée. Draw peut gérer plusieurs 
pages, mais la plupart des formats n’exporteront que la page courante. Les formats graphiques 
vers lesquels Draw peut exporter sont listés dans l’Annexe B, Open source, standards ouverts, 
OpenDocument de ce guide.

Vous pouvez également exporter les fichiers Draw aux formats HTML, XHTML, PDF ou Flash. 
L’export PDF pour les modules de LibreOffice est décrit au chapitre 10, Impression, Exportation et 
mailing, de ce guide.

L’export HTML utilise un assistant de conversion qui crée autant de pages web qu’il y en a dans 
votre document Draw. Vous pouvez choisir d’afficher les pages dans un cadre avec un navigateur 
et définir une page sommaire. Pour plus d’informations, reportez-vous au chapitre 12, Créer des 
pages web, de ce guide.

Insérer des commentaires dans un dessin

Vous pouvez insérer des commentaires dans votre dessin d’une manière similaire aux autres mo-
dules Writer, Calc ou Impress.

 1) Sélectionnez le menu Insertion > Commentaires. Une petite zone contenant vos initiales 
apparaît dans le coin haut gauche de la page, ainsi qu’une zone plus grande à côté (Figure 
48). Draw insère automatiquement votre nom et la date en bas de la boîte de texte.

 2) Entrez votre commentaire ou collez-le dans la zone de texte. Vous pouvez appliquer un for-
matage simple à différentes parties du texte, par clic droit et en le sélectionnant dans le 
menu contextuel. À partir de ce menu, vous pouvez également supprimer le commentaire 
courant ou tous les commentaires du même auteur ou tous les commentaires du document.

 3) La zone de commentaire se masque dès que vous cliquez à l’extérieur.
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 4) Vous pouvez déplacer les petits marqueurs de commentaire avec vos initiales à l’emplace-
ment souhaité sur le dessin. Il convient donc de les placer soit sur, soit au plus près de l’objet
auquel le commentaire fait référence.

 5) Pour afficher ou masquer les marques de commentaires, sélectionnez le menu Affichage > 
Commentaires.

 6) Sélectionnez le menu Outils > Options > LibreOffice > Données d’identité pour indiquer 
le nom que vous souhaitez voir apparaître dans le champ Auteur du commentaire.

 7) Si plusieurs personnes éditent le document, chaque auteur se verra automatiquement affec-
ter une couleur d’arrière-plan des commentaires différente.

Figure 48 : Exemple de commentaire
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